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Using Fillable PDF Forms as a Data Collection Method   

 
Abstract:  This document identifies general principles to consider when using fillable PDF forms 
as a data collection method. It also outlines a set of procedures for creating and distributing 
forms and extracting data from completed forms into Excel.   
 
This is not official ARM guidance. GAO specialists or analysts considering fillable PDF forms as 
a data collection method should be aware of current policy and procedures for conducting 
questionnaire surveys. Analysts are reminded that a key step in GAO’s Quality Assurance 
Framework is to consult with ARM or other qualified team experts to discuss data collection 
strategies, including the selection of appropriate software tools, before beginning data 
collection. 
 

Adobe software that can create fillable PDF forms exists on most GAO computers making it 
accessible to staff. These forms can be an appropriate mode of data collection for both internal 
and external questionnaires. However, care should be taken when designing and distributing 
forms and when extracting data into Excel. This document discusses design considerations and 
current procedures for using fillable PDFs.  

This set of procedures is current as of February 2014. Updates to Adobe software or agency-
wide computer settings may mean that some procedures described below could change. It is 
important to fully test PDFs on a variety of operating systems (not just on the GAO network) 
prior to distributing the forms to respondents.  

Fillable PDF forms can be created and distributed using one of two Adobe programs. The first 
method that seems to be less error prone is to convert Word questionnaires into PDFs using 
Adobe Acrobat Pro.  This set of procedures describes the process of converting Word 
questionnaires into PDFs using Adobe Acrobat Pro. The other method which seems to cause 
more errors is to create the PDF directly using Adobe LiveCycle Designer. A different set of 
procedures would apply if using Adobe LiveCycle Designer. Forms have to be created using 
either Adobe Acrobat Pro or LiveCycle Designer throughout the entire process. Forms cannot 
be edited by both programs.  

Similar to Word Electronic Questionnaires (WEQs), fillable PDF forms are usually sent to 
respondents as an e-mail attachment. Respondents save a copy of the PDF on their computer, 
complete the form, and e-mail it back to GAO. Fillable PDF forms have similar design 
considerations as other electronic surveys such as WEQs (See Appendix I of the Choosing a 
Survey Administration Method course for a more complete discussion of the strengths and 
weaknesses of using electronic questionnaires.)  However, fillable PDF forms have several 
advantages over WEQs:  

 The main advantage is that data from completed fillable PDF forms can be completely 
and easily extracted in to Excel, eliminating the need to have the questionnaires 
keypunched. This conserves agency resources and reduces the time between receiving 
completed questionnaires and beginning analysis. Even though it is also possible to 
extract data from WEQs into Excel or SAS, extracting data from fillable PDF forms 
requires little or no preparatory work: 

o In most cases, text responses in fillable PDFs do not need to be edited to remove 
special characters, bullets, and carriage returns. The only known character that 
can cause a problem is text that begins with - . Excel reads those entries as 
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formulas and may not read in the full text response correctly (in one case, a 
response was truncated at 256 characters).  

o Reading in data from fillable PDFs does not require the manual entry of column 
headers (variable names) in Excel. 

o Data from a large number of completed fillable PDFs can be read in at one time. 

 Because the completed forms do not need to be sent outside GAO for keypunch, the 
forms can also be used to collect certain sensitive information as long as other 
safeguards for distributing and analyzing the data are in place. (Note: Using fillable 
PDFs to collect data through SIPRnet has not been tested.) 

 Radio buttons (i.e. select-one-response questions) in fillable PDFs are restricted to only 
allow for one button to be checked. When extracted from a fillable PDF to Excel, only 
one variable will be created instead of one variable per response option as in WEQs. 

 Text fields in fillable PDFs can be formatted to vertically scroll instead of expanding 
down the page as in WEQs for greater control over what appears on each page of the 
questionnaire.  

 Skip patterns in fillable PDFs can be enforced to an extent by hiding or displaying 
subsequent fields if certain response options are selected. However, question stems 
cannot be hidden or displayed, just the response options. 

 While most respondents to GAO surveys are able to work with both Word and Acrobat 
files, PDF files may be compatible with applications freely available to more 
respondents.    

 Fillable PDF forms may perform better than WEQs on mobile devices. 

 

However, there are also several disadvantages of using fillable PDF forms compared to 
WEQs: 

 The questionnaire needs to be final in Word before creating the fillable PDF version. 

 There is no mail merge capabilities in fillable PDFs so prepopulating fields, like a GAO 
ID, can be tedious and time consuming. 

 JavaScript needs to be enabled on the respondent’s computer in order for certain 
features to work in fillable PDF forms, such as restricting entries to only numerals. 
Enabling JavaScript could lead to potential security issues and respondents may be 
reluctant to enable JavaScript. In those instances, the features in the fillable PDF form 
that require JavaScript may not work properly (e.g. respondents can enter letters in a 
field restricted to only numerals).  

 Using fillable PDF forms as a survey data collection method at GAO has a limited track 
record. 
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Creating and Distributing Fillable PDF Forms 
 

Step 1: Preparing final questionnaire in Word 

Develop a questionnaire in Word that reflects all final question wording and formats, including 
text formats, shading, skip pattern instructions, and spacing between questions. Delete any 
check boxes, text boxes, or other answer lines from the Word version because the PDF form 
fields that will get inserted might not fully overlay the Word form fields and it looks messy.  

It is difficult to make changes, even minor wording changes, after the word form has been saved 
as a PDF. If minor changes need to be made after the questionnaire has been converted to a 
PDF, it is possible to replace entire pages (see Replacing Pages). 

 

Step 2: Convert questionnaire to a PDF 

After the MS Word version of the questionnaire is final, convert it to a PDF. In the Word 
document, select the Acrobat tab and then Create PDF.  The PDF version should open in a 
new window in Adobe Acrobat. 

 

Step 3: Open PDF in editing mode 

In the PDF version, select the Forms tab and then Add or Edit Fields. The following pop-up 
should appear the first time that the form is opened in editing mode: 

 

 

 

Using autodetection does not save much time because the autodetection feature does not 
identify all of the fields, identifies fields where there should not be any, and defaults to setting 
each field as a text field.  The fields that are autodetected still need to be correctly formatted 
and placed in the form. After selecting either Yes or No, the form will open in the editing mode.  

 

 

 

 

 

Editing screen: 
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To preview what the field will look like in the final form, click on the Preview button on the 
toolbar. To return to editing mode, click on the Edit Layout button on the toolbar. 

 

 

 

Step 4. Enable JavaScript  

Some features available in fillable PDFs require JavaScript to be enabled in order to work 
properly. For example, restricting text fields to only accept numerals or a range of values 
requires JavaScript. If the respondent does not have JavaScript enabled on his or her computer 
those features may not work. Respondents worried about computer security may be reluctant to 
enable JavaScript in order to fill out the questionnaire.  

However, JavaScript should be enabled when creating the fillable PDF form. Other than for 
certain numeric fields, forms created with JavaScript enabled seem to work for respondents who 
have either JavaScript enabled or disabled on his or her computer. However, if JavaScript is 
disabled when the form is created, some form fields will not work properly if the respondent has 
JavaScript enabled on his or her computer. For example, text cannot be entered into a text box. 
Therefore it is recommended that JavaScript be enabled when creating the fillable PDF form. To 
enable JavaScript, click the Edit tab and then Preferences. Select JavaScript from the list of 
categories on the left and then click the box that states Enable Adobe JavaScript. Click OK to 
exit. 

 

Click one of these 
buttons to insert a field 

Click here to exit out of 
form editing mode. To re-
enter form editing mode, 
select the Forms tab and 
then Add or Edit Fields 

List of form fields will 
appear here 

Click here to hide 
forms toolbar. 
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Step 5. Adding form fields 

Manually insert a form field wherever a response needs to be captured.  There are five types of 
form fields available in fillable PDF forms and each is outlined below. Many of the procedures 
and options for inserting and formatting fields are the same across all five form field types. 
These procedures are discussed in detail in the first section on radio buttons; however, the 
procedures apply to the other four types of form fields as well. Any unique procedures per form 
field are discussed in detail in the appropriate section.  

(1) Select one response/ radio buttons.  

For select-one-response questions, the form designer will create a group of radio buttons that 
will have the same variable name, inserting one button at a time. Each radio button should have 
a unique button, or export, value. Only one column (variable) will be created in the spreadsheet 
when data are exported to Excel.  

To add radio buttons, click on the radio button icon on the toolbar. Drag and drop the blue box 
into place in the form. To resize a button, place cursor over field and a blue box should appear. 
Drag box dimensions to fit space. To show gridlines on the screen to aid with form field 
placement, right click anywhere on the page and then select Grid.  

A yellow box will appear where the form field can be named and formatted. The variable will 
also show up in the list of fields on the left of the screen. 

 

 

Enter the variable name under Radio Group Name. If more radio buttons are needed, select 
the link Add another button to group. Place that button in the correct space and rename the 
Button Value to the numeric value or text you want to export.  
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Setting form field properties as default formats:  

If this is the first time that a radio button (or other type of form field) is created in the form, it may 
be wise to first format the button’s properties and then set those properties as the defaults. To 
edit the field properties, click Show All Properties in the yellow box. Alternatively, right click on 
the field and select Properties. 

After editing properties, set the formats as defaults by right-clicking on the radio button and 
selecting the Use Current Properties as New Defaults.  

 

Copying and pasting fields 

To save time, fields can also be copied and pasted into the form and the formats will be 
preserved. For radio buttons, care should be exercised to then reset the export value to a 
different value.  Otherwise more than one response option will have the same export value 
when exported to Excel.  

For the remaining form field types, care should be exercised to then reset the variable name. 
Otherwise more than one field will have the same variable name and any responses entered to 
one field with the same variable name will be entered into all variables with that name. For 
example, if a text box with variable name of Text1 is copied and pasted the new field will also be 
named Text1. Any responses entered into the first Text1 will carry over to the other field. Fields 
with the same name will show up in the list of variables with a # following it. For example, Text1, 
Text#1, Text#2, etc.  

 

Editing form field Properties 

There are four tabs under Properties to select from. 

General tab 

 

 

Any changes made on the General tab will apply to all radio buttons in the group. 

 Name is the variable name that will be assigned when the data is exported to Excel. 

 Tooltip is any definition, instruction, or other information that should appear when the 
respondent places the cursor over the field. 
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 Form field indicates whether the field should be visible or hidden in the distributed form. 

 Read Only sets the field to read-only in the form. 

 Required makes the field a required field.  A red box will appear around the field, but it 
does not prevent the respondent from saving and returning the form without selecting a 
response. However, if the respondent tries to submit the form using the Submit button, 
he or she will receive an error message that a required field was not filled out. These 
should be used sparingly because requiring too many fields may frustrate respondents 
and result in them not completing the questionnaire.  

 Locked makes the field locked for further editing (although the box can later be 
unchecked to make edits) 

 

Appearance tab 

 

Use the options on the Appearance tab to format the appearance of the radio buttons, such as 
border and fill colors, and line thickness and style. It is recommended that form fields should 
have a fill color other than clear or white if the form background is white so that the fields are 
more easily recognized by respondents.  
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Options tab 

 

Use the Options tab to set button options such as style of the radio button and the value that 
will be exported, Button Value. It is also possible to preselect buttons, although this is generally 
not recommended in questionnaire design. 

Any formatting changes made to the Appearance or Options tab will only apply to a single 
radio button.  

Actions tab 
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Use the Actions tab to execute certain actions if a response option is chosen, such as opening 
an HTML link or hiding subsequent fields.  

To conditionally display or hide responses 

Note: Only response fields can be displayed or hidden, not the entire question. To hide a field, 
select Show/hide a field from the Select Action menu. Use the Select Trigger menu to 
indicate when the action should occur. The default setting here is Mouse Up which means that 
the action will execute after the respondent clicks the mouse and then releases the button. Click 
Add. 

Select the Hide button and then the field/variable that should be hidden. Click O.K. If more than 
one field should be hidden, click Add again to add more variables.   

 

 

If hiding variables, it is advisable to follow the same process to show variables for the other 
response option. In this example, the subsequent fields would be hidden if No was checked and 
shown if Yes was checked. If a respondent clicks No and the subsequent fields are hidden and 
then clicks Yes, the hidden fields will not reappear unless they are programmed to be shown if 
that field is checked.  Also note that the values in the conditional answer set will persist even if 
the filter response is changed to hide it.  

This feature should be used with caution and fully tested before distributing the fillable PDF 
form. It is best to use this option for simple skip patterns, such as displaying a text box to 
describe an “Other” response, rather than for skipping respondents over a larger set of 
questions.  

 (2) Check boxes.  

For check-all-that-apply questions, the form designer will insert a check box for each response 
option. Each box should be assigned a unique variable name (e.g. q2a, q2b, etc.). However for 
consistency when analyzing the data, the button, or export, value should be the same for each 
check box (i.e. if checked, will export value of 1). One variable (column) per check box would be 
created in Excel when the data is exported.  

To add a check box, click on the check box icon on the toolbar. Drag and drop the blue box into 
place in the form. A yellow box will appear where the form field can be named and formatted. 
The procedures and options for editing the check box field are the same as for radio buttons. 

Click on the check box icon on the toolbar to add another field or right click on a field that has 
already been placed in the form and copy and paste the check box. This will preserve the check 
box formatting, but be sure to assign different variable names to each of the check boxes. 
If two or more check boxes have the same variable name, then all of the boxes will be checked 
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in the form if the respondent clicks on a check box. Multiple check boxes can also be copied 
and pasted as a group if multiple questions have a similar number of response options. 

(3) Text boxes.  

Text boxes are any short-answer or open-ended field that can capture either text or numeric 
values. Each text box will exported to Excel as its own variable (column).  

To add a text box, click on the text box icon on the toolbar. Drag and drop the blue box into 
place in the form and size appropriately. A yellow box will appear where the form field can be 
named and formatted. Many of the procedures and options for editing the check box field are 
the same as for radio buttons. However, there are some additional formatting options in the 
Properties tab for text boxes that are described below.  

The Appearance tab has the added option that allows you to select the font size, text color, and 
font style of the text that respondents will enter in the box. Be sure to preview how the text will 
look to make sure that the text is not too small or large and is generally readable on the screen. 

 

Options tab 

 

Use the Options tab to set the following: 

 Alignment sets whether the text entered in the box will be left-, center-, or right-justified. 

 Default Value is any text that should initially appear in the box. Note that the text will 
remain in the box when the respondent begins typing. It will not be overwritten by any 
response entered. 

 Multi-line allows for more than one line of text to appear in the box. This option is 
recommended for open-ended responses so that the full response is readable. 
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 Scroll long text allows text to scroll at the end of long responses. This option is 
recommended for open-ended responses that may be lengthy. Even if the full response 
does not display in the text box, the full response will export into Excel.  

 Allow Rich Text Formatting should allow respondents to format text in the box 

 Limit of X characters will limit the response to X characters. Default limit? 

 Password will display **** in the box instead of characters. It is only an option if Multi-line 
is not checked. 

 Field is used for file selection permits a file path to be specified as part of the field’s 
value. The file is submitted along with the form data (explanation from Adobe manual; this 
has not been tested). 

 Check spelling will indicate misspelled words with a red underline 

 Comb of X characters will bisect the field into X sections that allows for only one character 
per section (e.g. when entering a SSN) 

 

Format tab 

 

Use Format tab to format the type of information allowed in the box. The default setting is None 
which allows for all types of characters and numerals. The other formats require the respondent 
to have JavaScript enabled in order to work properly. For example, JavaScript would need to be 
enabled for the Number field to only accept numeric values. If the respondent has JavaScript 
disabled, the field will accept any text entered.  If any of these formats are used in the form, 
extra care should be paid to review respondent’s entries to make sure that they are formatted as 
intended.  

If a format other than None is selected then additional options will appear on this tab for 
formatting the number of decimal places, use of comma separators, and how to display negative 
numbers. Also, options on the Validate and Calculate tab are only functional if the format is set 
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to a category other than None. A range of valid values can be set on the Validate tab. Fields 
can be set to be the sum, product, average, minimum, or maximum of other fields on the 
Calculate tab. Because these features may not work if respondents do not have JavaScript 
enabled, use with caution. However, these could be appropriate for an internal DCI if all 
analysts enabled JavaScript.  

 

(4) Drop-down boxes.  

Drop-down boxes are typically used if there is a long list of possible response options, the full 
list of options is generally known to respondents, and respondents readily know what their 
response will be (e.g. list of States, GAO missions teams, etc.). One drop-down box field will be 
created in the form and the items in the list will be entered in the Properties tab. One variable 
(column) per drop-down box would be created in Excel when the data are exported.  

To add a drop-down box, choose the Drop-down Box (Adobe names this the Combo Box) icon 
on the toolbar. Drag and drop the blue box into place in the form and size appropriately. A 
yellow box will appear where the form field can be named and formatted. Many of the 
procedures and options for editing the check box field are the same as for radio buttons. 
However, there are some additional formatting options in the Properties tab for text boxes that 
are described below.   

Options tab 

 

The Options tab is where the drop-down list will be created. Enter the first item in the drop-
down list in Item and the value that should be exported to Excel in Export Value, then select 
Add. If no Export Value is entered then the default export value will be what appears in the item 
list. The item will then appear in the Item List. Add the remaining items to the list. If Sort Items 
is selected when entering the items, the list will automatically be alphabetized.  
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It is recommended that a <select one> or other default option be added to the top of the list; 
otherwise, the first item in the list would become the default response. The item in the item list 
that is highlighted/selected will become the default selection in the drop-down box. 

The export value could be set to a different value, such as a 0, or could remain as <select one>. 

If Allow user to enter custom text is selected then respondents can enter his or her own 
response into the drop-down menu instead of only being allowed to select one of the items in 
the list. This is generally not recommended in order to preserve the uniformity of the list and 
export values. If this option is allowed and a respondent enters his or her own response then 
whatever text is entered is what will be exported to Excel.  

Commit selected value immediately should immediately save the response selected in the 
drop-down box. If this box is not checked then the response is not saved until after the 
respondent exits the field by tabbing to another field or clicking the mouse outside the field. 

(5) List boxes.  

The List Box icon on the toolbar  is similar to the Drop-down icon  except that the items 
in the List Box will display in a box without a drop-down arrow (see above section on Drop-down 
boxes for formatting options). The advantage of the List Box over the Drop-down box is that all 
possible response options could be displayed on the screen at one time if the box is sized 
correctly. However, if the list of options is long, displaying the entire list on the screen may add 
unnecessary length to the questionnaire. If the list is longer than the size of the box, scrolling 
arrows will appear on the right side of the box.  

The List Box will also allow for multiple responses if the respondent holds down the Ctrl key 
while clicking on each response. However, the drop-down box will only allow for one response. 
To allow for more than one response, make sure the Multiple Selection box is selected on the 
Options tab. However, only one variable will be exported to Excel even if multiple responses 
are selected. In the above example, the exported value would be ‘CDMACEMI’ which could 
complicate analysis. If more than one response options is desired, it is best to use a check-all-
that-apply (check box) question. 

Step 6. Check the tab order of form fields 

It is important to check the tab order of the form fields because some respondents may use the 
Tab key to navigate through the form. The tab order is also the order in which the variables will 
appear in the Excel file. The default tab order will be set based on the order in which form fields 
are created. To show the tab order, select the Tab Order button and then Show Tab Numbers. 
A number will appear in the upper left corner of each form field that indicates the tab order for 

List Box with multiple 
responses selected Drop-

down Box 
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form fields on that page. The tab order will start over at 1 on subsequent pages. To change the 
tab order, drag and drop form fields in the left column. 

 

 

 

Step 7. Replacing pages (optional) 

If any minor changes are made after the PDF form has been created, it is possible to replace 
pages. First, the changes should be made in the Word version of the questionnaire. The page 
with the change should be saved as its own separate one-page file. In Adobe Acrobat, click the 
Close Form Editing button in the upper right corner if the editor is open. Click on the 
Document tab and then Replace Pages. Select the file that is the replacement page. Then 
select which page of the PDF should be replaced. The form fields that appeared on the old page 
should now appear in the new page. However, they may need to be formatted and placed 
correctly on the screen once again. Be sure to double-check the tab order. 

 

Step 8. Save the form under a new file name 

Once the form is final, save it under a new file name. No additional edits can be made to the 
form after it has been run through the distribution wizard in Step 9 so it is a good idea to keep a 
working copy.  

Also, it may be a good idea to save this new file out of DM and complete the remaining steps on 
local copies of files because the distribution process and reading in data and then exporting to 
Excel has not been fully tested in DM. Be sure to back up files. Once data collection ended, the 
completed questionnaires and final Excel file can be saved in DM.  

 

Step 9. Run the form through the distribution wizard 

Numbers in upper 
left corner show 
the tab order 

Drag and drop 
form fields here to 
change tab order. 



GAO internal guidance/resource – 7/17/17 
 
 

Using Fillable PDF Forms as a Data Collection Method – Update February 2014  
 

In the new file created in step 8, click on the Forms tab and then Distribute Form. A message 
may appear indicating that the form already contains values. When previewing the form in the 
editing mode, any form field that was selected contains a value. Click Yes to clear the values. 

 
 

When asked how you want to collect responses, select Manually collect responses in my 
email inbox. Click Next. 

 
 

When asked how you want to distribute the form, select Save a local copy and manually send 
it later and then select the file location where you want to save the distribution-ready version of 
the form. Click Next.  

The first time you run a form through the distribution wizard, you may get a window asking to set 
preferences on what information is identified to respondents and what information should be 
automatically collected from respondents. Be sure to enter your e-mail address as the e-mail 
that forms should be returned to if a Submit button appears on the screen (see Submit button). 
This option will not appear again when subsequent forms are run through the distribution 
wizard.  

Confirm method of form distribution on the next screen and then click Finish. 

 
 

The distribution wizard created two files. The PDF with the _distributed in the file name is the 
form that should be e-mailed to respondents. The PDF with the _responses is the file that you 
will use to read in the completed forms and convert to Excel. 
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A Tracker window will also open. However, the tracking feature does not seem to currently work 
on the GAO system so ignore it. It is not needed to either distribute or read in forms. 

Note about Submit button. According to the Adobe Acrobat User Guide, a Submit button is 
supposed to appear in the upper right corner of the form after it has been run through the 
distribution wizard. However, this button may not appear when viewing the form on a GAO 
computer because of agency security settings. ISTS also determined that the appearance of the 
submit button depended on the version of Acrobat the form was created in as well as the 
version on which it was viewed. Some respondents may see the button and others may not. 
There is not a way to turn off the Submit button so that no respondent sees it. The respondent 
does not need to submit the form using the Submit button in order for it to be read into Excel 
properly. Forms that are e-mailed back as attachments can also be read into Excel. 

ISTS agreed that the best solution was to instruct the respondents to save the form and attach it 
to an e-mail instead of relying on the Submit button. The following instruction could be added to 
the questionnaire: 

Once your survey is complete, please first save a copy for your records. You may e-mail your 
completed form to xxxx@gao.gov. Or, if a Submit button appears in the upper right corner of 
your screen you may also click this button to submit your form (some viewers will not see this 
button because of certain security settings on your computer system). 

 

Adding unique GAO ID numbers or other prepopulated variables (optional) 

It can be useful for tracking purposes to assign a unique GAO ID to each questionnaire. 
However, it can be tedious to do this in PDF fillable forms. The GAO ID has to be manually 
changed in each form and then that form has to go through the form distribution process. For 
that purpose, it may be better to use a variable that respondents need to fill in to identify forms 
(e.g. program name, state, etc.) Having a unique ID would be most useful if the questionnaires 
contain sensitive information and no identifying information should be included in the analysis 
file, although a unique ID could always be added to the Excel file after the responses are read 
in.  

To add an ID, insert a text field where the ID should appear. Right click on the field and select 
Properties. On the General tab, rename the variable as GAOID and click the Read Only box. 
On the Appearance tab, make sure the fill color is set to No Color. On the Options tab, enter or 
change the GAO ID number in the Default Value box. Close the Properties box. 

In the upper right corner of the PDF, click on the Close Form Editing button. This takes you 
back to the normal PDF viewer. 
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Complete step 8 described above. Click the File tab, then Save As to save the file under a new 
document name. I would put the GAOId number in the file name to keep track of which file is 
which. 

Complete step 9 by running the form through the distribution wizard. Separate files with the 
_distributed and _responses in the file name will be created for each personalized form. 
However, all distributed forms can be read into the same _responses file. It does not matter 
that each form was run through the distribution wizard individually. If all of the form fields are the 
same, the forms can be read into any _responses file created from a form.  

 

Step 10. Pilot test the completed forms.  

It is a good practice to pilot test the completed forms which includes reading in data from 
completed forms and exporting it to Excel (steps 12 and 13). If any errors are found, correct the 
errors and retest the forms.  

 

 

Step 11. E-mail forms to respondents. 

Congratulations! The forms are now ready to be e-mailed to respondents. Remember to e-mail 
the forms with the _distributed in the file name. It is a good idea to rename the form for each 
respondent so the file names are unique.  

 

Step 12. Read in completed forms. 

It is helpful to create a folder that contains all of the completed questionnaires. Open the file 
created in Step 9 that contains the _responses in the file name. If a welcome screen appears, 
click the Get Started button at the bottom. 

Click the Add button on the left to add completed questionnaires.  
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Then click Add File to locate saved completed questionnaires. Highlight those completed 
questionnaires that should be exported to Excel. Click Open. The completed questionnaires 
should then appear in the Form File list. Click OK to upload files. The responses should then 
appear in the _responses file. It is a good practice to compare the values that appear in the 
_responses file with the values that were reported in the completed questionnaires to ensure 
the data was read in correctly.  

 

Step 13. Export data to Excel.  

Click the Export tab on the left and then either select Export all… to export all of the records, 
or select Export selected… to only export the records that are highlighted. 

 

Choose a folder where the file should be saved and a file name. Click Save. The file will be 
saved as a CSV file. To create an Excel file, click Save As and then select Excel Workbook as 
File Type. If you want to edit the file, first save it as an Excel file; otherwise changes made to 
the CSV file may not be saved.  

Column A will contain the file name from which the responses were read in. If this variable is 
being used to identify the respondent instead of another unique variable, like a GAO ID, 
DOUBLE CHECK THAT THE RESPONSES FOR THAT FILE IN EXCEL MATCH THE 
RESPONSES IN THE COMPLETED PDF FORMS. For unknown reasons, in some instances 
the file names do not match.  
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As a quality control measure, it is a good practice to compare a select number of completed 
forms against the exported values in excel. There is no set number that should be compared; it 
depends on how fully the form was tested prior to distribution and those results documented, the 
types of form fields used (i.e. numeric values should probably be more thoroughly verified than 
text), and how key the data is as a source of evidence. For the survey of banks, two team 
members independently verified  all responses in each form to the Excel file because it was one 
of the first times fillable PDFs had been used and many of the fields asked for numeric 
information where formatting is important. 

Regular edit checks, like looking for skip pattern errors or potential outliers, can be performed 
simultaneously when checking completed PDF forms against the responses in Excel. 


